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1 Important Notes 
This section provides a summary of the most important safety requirements and 
notes which are also mentioned in the individual sections. To protect your health 
and prevent damage to the devices, it is essential to read and carefully follow the 
safety guidelines. 

1.1 Legal Principles 

1.1.1 Copyright 

This manual including all figures and illustrations contained therein is subject to 
copyright. Any use of this manual which infringes the copyright provisions 
stipulated herein, is not permitted. Reproduction, translation and electronic and 
phototechnical archiving and amendments require the written consent of WAGO 
Kontakttechnik GmbH & Co. KG, Minden. Non-compliance shall attract claim 
for damages. 

WAGO Kontakttechnik GmbH & Co. KG reserves the right to enact changes that 
serve technical progress.  
All rights arising from the issue of a patent, or the legal protection of utility 
patents, are reserved to WAGO Kontakttechnik GmbH & Co. KG. Third-party 
products are always indicated without any notes concerning patent rights. Thus, 
the existence of such rights must not be excluded. 

1.1.2 Personnel Qualification 

The use of the product described in this manual requires special qualifications, as 
shown in the following table: 

Table 1: Personnel Qualification 
Activity Electrical specialist 
Assembly X 
Commissioning X 
Programming X 
Maintenance X 
Troubleshooting X 
Disassembly X 
 
All personnel must be familiar with the applicable standards. 
WAGO Kontakttechnik GmbH & Co. KG declines any liability resulting from 
improper action and damage to WAGO products and third-party products due to 
non-observance of the information contained in this manual. 
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1.1.3 Proper Use of the TO-PASS® Telecontrol Modules 

The TO-PASS® telecontrol modules receive digital and analog signals from 
sensors and transmit and output them to higher-ranking controllers. Additionally, 
it is possible to (pre-)process them. 

The device is designed for the IP20 protection class. It is protected against the 
insertion of solid items (e.g, fingers) and solid impurities up to 12.5 mm in 
diameter, but not against water penetration. Unless otherwise specified, the device 
must not be operated in wet and dusty environments. 

1.1.4 Technical Condition of the Devices 

For each individual application, the components are supplied from the factory 
with a dedicated hardware and software configuration. Changes in hardware, 
software and firmware are only admitted within the framework of the possibilities 
documented in the manuals. All changes to the hardware and/or software and the 
non-conforming use of the components entail the exclusion of liability on the part 
of WAGO Kontakttechnik GmbH & Co. KG. 

Please direct any requirements pertaining to a modified and/or new hardware or 
software configuration directly to WAGO Kontakttechnik GmbH & Co. KG. 
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1.2 Standards and Regulations for Operating the TO-
PASS® Telecontrol Modules 
Please observe the standards and regulations that are relevant to installation: 

• The data and power lines must be connected and installed in compliance 
with the standards to avoid failures on your installation and eliminate any 
danger to personnel. 

• For installation, startup, maintenance and repair, please observe the accident 
prevention regulations of your machine (e.g., BGV A 3, "Electrical 
Installations and Equipment"). 

• Emergency stop functions and equipment must not be deactivated or 
otherwise made ineffective. See relevant standards (e.g., DIN EN 418). 

• Your installation must be equipped in accordance to the EMC guidelines so 
electromagnetic interferences can be eliminated. 

• Please observe the safety measures against electrostatic discharge according 
to DIN EN 61340-5-1/-3. When handling the modules, ensure that 
environmental factors (persons, workplace and packing) are well grounded. 

• The relevant valid and applicable standards and guidelines regarding the 
installation of switch cabinets must be observed. 
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1.3 Symbols 

 
 DANGER  

Warning of physical injury 
Indicates a direct hazard with a high level of risk, which may lead to death or 
severe physical injury if it is not avoided. 

 

 

DANGER  
Warning of physical injury due to electric current 
Indicates a direct hazard with a high level of risk, which may lead to death or 
severe physical injury if it is not avoided. 

 
 WARNING  

Warning of physical injury 
Indicates possible hazard with a moderate level of risk, which may lead to death 
or (severe) physical injury if it is not avoided. 

 
 CAUTION  

Warning of physical injury 
Indicates possible hazards with a low level of risk, which will lead to minor or 
moderate physical injuries if it is not avoided. 

 
 NOTICE  

Warning of damage to equipment 
Indicates possible hazard that could lead to equipment damage if it is not avoided.

 

 

NOTICE  
Warning of damage to equipment by electrostatic discharge 
Indicates possible hazard that could lead to equipment damage if it is not avoided.

 
NOTE: 

 

Please note 
Indicates possible malfunction, which does not lead to equipment damage if 
it is not avoided. 

Information 

 

Notes on additional information 
Indicates other informations, which are not an integral part of this 
documentation, such as Internet. 
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1.4 Safety Information 

 
 DANGER  

Warning of physical injury 
TO-PASS® telecontrol modules are exposed operating equipment. They may only 
be assembled in housings, cabinets or in electrical operation rooms. Access is 
only permitted via a key or tool to authorized qualified personnel. 

 
 DANGER  

Warning of physical injury 
All power sources to the device must always be switched off before performing 
any installation, repair or maintenance work.. 

 
 NOTICE  

Warning of damage to equipment 
The components are not resistant against materials having seeping and insulating 
properties such as: aerosols, silicones, triglycerides (found in some hand creams). 
If it cannot be determined that these materials appear in the component 
environment, then the components must be installed in an enclosure that is 
resistant against the above mentioned materials. Clean tools and materials are 
generally required to operate the device/module. 

 
 NOTICE  

Warning of damage to equipment 
Soiled contacts must be cleaned using oil-free compressed air or with ethyl 
alcohol and leather cloths. 

 
 NOTICE  

Warning of damage to equipment 
Do not use contact sprays, which could possibly impair contact area functionality.

 
 NOTICE  

Warning of damage to equipment 
Avoid reverse polarity of data and power lines as this may damage the devices. 

 

 

NOTICE  
Warning of damage to equipment by electrostatic discharge 
The devices are equipped with electronic components that may be destroyed by 
electrostatic discharge when touched. 
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1.5 Font Conventions 
Table 2: Font Conventions 
Font type Indicates 
italic Names of paths and files are displayed in italics, e.g.:  

C:\Programme\WAGO-IO-CHECK 
Menu Menu options are displayed in bold, e.g.:  

Save 
> A greater-than sign between two names means the selection of a 

menu option from a menu. e.g.: 
File  > New 

Input Designation of input or optional fields are displayed in bold, e.g.: 
Start of measurement range 

“Value” Input or selective values are displayed in inverted commas, e.g.: 
Enter the value “4 mA” under Start of measurement range. 

[Button] Button names in dialog boxes are displayed in bold in square 
brackets, e.g.: 
[Input] 

[Key] Names of keys on the keyboard are displayed in bold in square 
brackets, e.g.: 
[F5] 

 

1.6 Number Notation 
Table 3: Number Notation 
Number code Example Note 
Decimal 100 Normal notation 
Binary '100' 

'0110.0100' 
Within ', 
Nibble separated with dots 
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2 Use 
The TO-PASS® product family is designed for wireless communication of signals 
and messages. 

This includes: 

• compact module for the connection of signals from plants 
• transmission 
• preparation of values for the operator. 

The system is connected in wireless mode to PCs, hand computers, Internet PCs, 
web servers, mobile telephones, fax, e-mail receivers or land-line telephones. 
Influences to the system are also possible. 

Communication occurs using the global mobile radio network “GSM” (Global 
System for Mobile Communication). A SIM card is required for the TO-PASS® 
telecontrol module to use this network. As in the case of a mobile telephone, the 
TO-PASS® telecontrol module requires the SIM card in order to be able to “log 
on” to the network. 

No other components are required, other than the SIM card to connect to the GSM 
mobile radio network and a GSM antenna (available as an accessory). Modems 
and interfaces are already installed in the TO-PASS® telecontrol module. 

TO-PASS® telecontrol modules may be used as: 

• permanent on-line link 
• fault indicator 
• remote data request system 
• data memory 
• telecontrol modules. 

In doing so, the modules of the WAGO TO-PASS® are classified as follows: 

• WAGO TO-PASS® S - “S” = small, compact module 
• WAGO TO-PASS® M - “M” = medium, universal compact module. 



12 Products   
    

  WAGO TO-PASS® 
  Telecontrol Modules S 761-10x 

3 Products 
Table 4: Products 
Item number Name 
761-100 Telecontrol Module S,  

4 digital inputs, 4 digital outputs 
761-101 Telecontrol Module S 8AI,  

4 digital inputs, 4 digital outputs,  
2 analog inputs 

761-102 Telecontrol module S 8AI ESP,  
4 digital inputs, 4 digital outputs,  
Internet access via GPRS 

761-103 Telecontrol module S 8AI DSP,  
4 digital inputs, 4 digital outputs,  
2 analog inputs 
Internet access via GPRS 

 

4 Scope of Delivery 
The scope of delivery of the TO-PASS® S telecontrol module, without options, 
includes only the TO-PASS® S telecontrol module. Suitable antennas are available 
as accessories. 

NOTE: 

 

SIM Card 
Please note that one SIM card is required to operate each TO-PASS® S 
telecontrol module and may be obtained from typical service providers such as 
T-Mobile, VODAFONE or EPlus. WAGO Kontakttechnik GmbH & Co. K.G. 
is prepared to assist with the selection of the most cost-effective tariff for your 
application. 
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5 View 

Com

Busy

Run

StatusSIM PC

2 3 4

1

5

 

Figure 1: Front view 

Position Description 
1 Antenna connection 
2 SIM Card insert 
3 Status indication 
4 PC Interface 
5 Connecting terminals for the supply, inputs and outputs 
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6 Installing the Operator Software 
1. Insert the CD with the TO-PASS® operator software in the CD ROM drive 

of the PC 

2. Close all applications allowing the Operating System to display the 
Desktop. 

3. Move the mouse cursor to the “Start” button of the Windows Operating 
System and click on the right mouse button. 

4. Select Windows “Explorer” using a double click. 

5. Select the CD ROM drive where the operator software will be inserted. 

6. Select the main directory of the CD and start the program “WAGO-TO-
PASS_SETUP(x.yy).EXE”. 

7. Follow the menu guide to choose a default installation path. 

8. The installation is complete when the message “The software has been 
installed successfully” is displayed. 
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7 Assembly 
7.1 Installation 

1. The TO-PASS® S telecontrol module is designed to mount on a DIN 35 
carrier rail. 

2. The protection class of the TO-PASS® S telecontrol module is IP 20.  
This is why it is recommended that the module is mounted in a housing or a 
in a switching cabinet. 

3. The TO-PASS® S telecontrol module is designed for an ambient operating 
temperature range of -20 ºC to +70 ºC.  
In the event of higher or lower temperatures, proper cooling or heating 
arrangements must be provided.  
Please contact WAGO Kontaktechnik GmbH & Co. K.G. for assistance. 
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7.2 Terminal Assignment 
After installation, connect the wires depending on their use according to the 
following connecting diagrams: 

7.2.1 Operating Voltage 

Table 5: Terminal assignment for operating voltage 
 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

 
Figure 2: Terminal assignment for operating voltage 
 
Connection Short name Designation 
1 Uv Operating voltage (+) 8 to 36 VDC 
2 Uv Operating voltage (+) 8 to 36 VDC  

(parallel to teminal 1) 
3 GND Operating voltage (-) "Ground" 
4 GND Operating voltage (-) "Ground"  

(parallel to terminal 3) 
38 Shield Enclosure screening, connection of the PE 
 

7.2.2 Digital Inputs 
Table 6: Terminal assignment for digital inputs 
 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

 
Figure 3: Terminal assignment for digital inputs 
 
Connection Short name Designation 
5 DI 1 Digital input 1 
6 DI 2 Digital input 2 
7 DI 3 Digital input 3 
8 DI 4 Digital input 4 
9 -- Not assigned 
10 -- Not assigned 
11 -- Not assigned 
12 -- Not assigned 
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7.2.3 Analog Inputs 
Table 7: Terminal assignment for analog inputs 
 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

 
Figure 4: Terminal assignment for analog inputs 
 
Connection Short name Designation 
13 AI1+ Analog input 1 (+) 
14 AI1- Analog input 1 (-) 
15 AI2+ Analog input 2 (+) 
16 AI2- Analog input 2 (-) 
17 -- Not assigned 
18 -- Not assigned 
19 -- Not assigned 
20 -- Not assigned 
21 -- Not assigned 
22 -- Not assigned 
23 -- Not assigned 
24 -- Not assigned 
25 -- Not assigned 
26 -- Not assigned 
27 -- Not assigned 
28 -- Not assigned 
 

7.2.4 Digital Outputs 
Table 8: Terminal assignment for digital outputs 
 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

 
Figure 5: Terminal assignment for digital outputs 
 
Connection Short name Designation 
33 DO 1 Digital output 1 
34 DO 2 Digital output 2 
35 DO 3 Digital output 3 
36 DO 4 Digital output 4 
37 DO Vcc (+) Voltage for the digital outputs 
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7.2.5 Analog Outputs 
Table 9: Terminal assignment for analog outputs 
 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

 
Figure 6: Terminal assignment for analog outputs 
 
Connection Short name Designation 
29 -- Not assigned 
30 -- Not assigned 
31 -- Not assigned 
32 -- Not assigned 
 

7.2.6 Antenna 

The screw connector (FME plug) for the GSM antenna is located at the top of the 
housing. 

 

Figure 7: Antenna connection 
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7.2.7 Serial interface to the PC 
Table 10: PC Interface 

Pin Description 

1 Not assigned 
2 RXD 
3 TXD 
4 Not assigned 
5 GND 
6 Not assigned 
7 Not assigned 
8 Not assigned 

PC

12345

9 8 7 6

 
Figure 8: 
PC Interface 9 Not assigned 
 

Table 11: Interface cable allocation 
WAGO TO-PASS PC 

Pin Description  Pin Description 
2 RXD  2 RXD 
3 TXD  3 TXD 
5 GND  5 GND 

 

NOTE: 

 

Connecting laptops and PCs without serial interface: 
If the laptop or PC does not have a serial interface, use the USB adapter 
761-9005, which is available as an accessory. 
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7.3 Examples of Connection 

7.3.1 Digital Inputs 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

DI1

 

Figure 9: Example of connection for switch at input DI1 

7.3.2 Analog Inputs 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

AI1
X

I

+

-  

Figure 10: Example of connection of transducer at input AI1 



  Assembly 21 
    

WAGO TO-PASS®   
Telecontrol Modules S 761-10x   

7.3.3 Digital Outputs 

7
DI3 DI5

11
DI7

5
DI1

13
AI1
+

15
AI2
+

3
GND

1
Uv

17
AI3
+

19
AI4
+

21
AI5
+

23
AI6
+

31
AO2

+

33
DO1

35
DO3

29
AO1

+

37
DO
Vcc

27
AI8
+

25
AI7
+

9

8
DI4 DI6

12
DI8

6
DI2

14
AI1

-

16
AI2

-

4
GND

2
Uv

18
AI3

-

20
AI4

-

22
AI5

-

24
AI6

-

32
AO2

-

34
DO2

36
DO4

30
AO1

-

3828
AI8

-

26
AI7

-

10
Shield

DO1

 

Figure 11: Example of connection of relay at output DO1 
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8 Display Elements 
Table 12: Display Elements 

Com Busy Run 
green green green Description 

On On On 

Initialization phase,  
after start-up, approx. 50 s,  
check and log on to the GSM 
network 

On Off On Communication via RS232 
interface 

Off On On Communication via GSM 
modem 

Off Off 2 Hz 
blinking Error 

Com

Busy

Run

Status  
Figure 12: Display 
Elements 

Off Off 0.5 Hz 
blinking Ready 
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9 Commissioning 
NOTE: 

 

Do not switch on yet! 
Switch on the TO-PASS® S telecontrol module only after being prompted to 
do so; do not insert the SIM card for this procedure. 

NOTE: 

 

Deactivate the PIN! 
During the commissioning, the SIM card may be disabled when a faulty or 
incomplete PIN number is entered. 
Therefore it is recommended that you disable the PIN of the SIM card to be 
inserted. For this purpose, insert the SIM card in a mobile telephone and 
select the menu option Security > Disable PIN. 

NOTE: 

 

Deactivate the call diversion 
Deactivate all call diversions of the SIM card to be inserted to achieve a 
trouble-free availaility of the TO-PASS® S telecontrol module. 

As the first step, the TO-PASS® S telecontrol module must be configured with a 
telephone number. 

1. Each TO-PASS® S telecontrol module requires a SIM card for operation, 
which may be obtained from any mobile telephone service provider. Special 
data cards are recommended. 

2. Each SIM card contains a telephone number and a PIN code, which the SIM 
card enables for operation in the TO-PASS® S telecontrol module. Keep this 
telephone number and PIN code at hand. 

3. Connect the PC to the mounted TO-PASS® S telecontrol module via serial 
interface. 

4. If the PC has only USB interfaces, a USB – RS-232 adapter is required.  
A USB adapter is available as an accessory 761-9005. 

5. Start the PC and then the TO-PASS® operator software. 

6. Select the menu option File > Set. 

7. Set this as a “RS232” connection and select the respective interface, e.g. 
“COM1”. 

8. Select the menu option File > New Module. 

9. In the input window enter the identity (max. 8 characters) of the new device. 
The identity is the name of the TO-PASS® S telecontrol module and serves 
as an identifier. It can be changed subsequently only after overwriting it. 
The identifier is also transmitted in the event of error messages as SMS, fax, 
or e-mail and should be an identifier for the location of use, such as 
“Tank1”. 
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10. A new module will be created at the top left of the screen in the project tree. 
Click on “+” so the tree expands. Go to “Identity” and enter the telephone 
number of the SIM card in the second line at the top right of the screen. 
Deactivate the pushbutton [Use PIN] in the following line so that the TO-
PASS® S telecontrol module does not use the PIN Code. Also deactivate the 
PIN Code on the SIM Card! For this purpose, insert the SIM card in a 
mobile telephone and select the option Disable PIN in the Security menu. 

11. If the PIN Code has to be used, activate the [Use PIN] button in the TO-
PASS® operating software. Also activate the PIN Code of you SIM-Card 
using your mobile telephone. 

12. The telephone number should be the data number of the SIM card if it is 
available. If using a tariff that does not offer any data transmission options 
(which means that no data number is available) then, apart from SMS, e-
mail and fax operation, it is possible to select the TO-PASS® S telecontrol 
module via remote configuration only with the help of a GSM modem. 

13. Switch on the power to the TO-PASS® S telecontrol module. Shortly 
afterward, the “Busy” LED will flash. 

14. Select the menu option Edit > Write Parameters in the operator software. 
The operator software now transmits the parameters in the TO-PASS® S 
telecontrol module. 

15. After error-free transmission, switch off the TO-PASS® S telecontrol 
module. 

16. Carefully push the SIM Card into the SIM Card slot of your TO-PASS® S 
telecontrol module (e.g. using a screw driver) until it locks into position. 
The SIM Card is then positioned 2 mm within the enclosure.  
The SIM Card is released by pressing it again. 

17. Switch on the TO-PASS® S telecontrol module again and wait until the 
initialization phase is complete. The initialization phase ends when the 
“Run” LED lights up with brief flashes. 

18. The TO-PASS® S telecontrol module is now ready for use and configuration. 
For this purpose, follow the instructions given in the “Configuration” 
section. 
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10 Parameter Setting 
10.1 General Settings 

Select the menu point File > Settings, for carrying out general settings, such as 
type of connection, interface or language for the TO-PASS® operating interface. 

 

Figure 13: General settings 

Connection 
RS232 / GSM / 
Analog / ISDN 

Select the type of connection for communicating with the 
TO-PASS® S telecontrol module: 
RS232  Direct connection via the RS232-Cable, 
GSM  Access via GSM-modem at the PC, 
Analog  Access via analog modem at the PC, 
ISDN  Access via ISDN-modem at the PC. 

Comport 
COM1 ... COMx Here, select the serial interface where the communication 

cable is connected with a RS232 connection. 
Language 
English / German / 
French 

Select the language for the TO-PASS® operator interface 
here. 

 

Using the button [Save], the settings are taken over and the dialog window is 
closed. 

Using the button [Cancel], the dialog window is closed without taking over the 
settings. 
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10.2 Read Parameters 
After you have set the type of connection for communicating with the TO-PASS® 
S telecontrol module, you are then able to read-out the parameters of the 
connected module. 

For this purpose, select the menu point Controller > Read Parameters. The 
software now reads out all the parameters of the TO-PASS® S telecontrol module. 

Then you can adapt the parameter according to your requirements. 
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10.3 Identity 
Select the TO-PASS® S telecontrol module to be configured from the project tree; 
under it, select the Identity option.  
On the right side you will find the display field for the name, the input field for 
the telephone number, buttons and input fields for the PIN and roaming and the 
input field for the alarm counter. 

 

Figure 14: Configuring the identity 

General 
Name The module name is assigned when a new module is set 

up and cannot be subsequently changed. 
Phone Enter the telephone number of the SIM card inserted into 

the module. 
Pin If you wish to use the PIN number of the SIM card 

inserted, press the [Use pin] button and enter the PIN 
number. 

Roaming If you want to enable roaming, press the [Enable] button.
Alarm counter If you want to limit the number of alarms transmitted 

each minute (e.g., in case of a damaged cable), then enter 
the maximum number of desired alarms here. 
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10.4 Addresses 
The TO-PASS® S telecontrol module can communicate with a maximum of four 
transmitters/receivers via GSM.  
Messages are sent by the TO-PASS® S telecontrol module as SMS: however, they 
can also be sent as an e-mail, fax or voice mail through configuration. 
In addition, the TO-PASS® S telecontrol module can transmit messages to an 
Internet address. 

Select the TO-PASS® S telecontrol module to be configured from the project tree 
and the option Addresses.  
The input fields for the addresses are on the right side: 

 

Figure 15: Configuring the addresses 
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Phone/Fax/Mail 
Address 1  
 ... Address 4 

Transmission as SMS:  
Simply enter the mobile telephone number of the 
receiver.  
Press the pushbutton [T2T], when the SMS receiver is 
also a TO-PASS® telecontrol module, e.g. when alarm 
messages should be used as switching commands in the 
other TO-PASS® telecontrol module. 
 
Transmission as e-mail:  
First enter the e-mail identifier of the provider of the SIM 
card inserted in the WAGO-TO-PASS® telecontrol 
module. The following codes are applicable: 
- T-Mobile:  8000 
- VODAFONE:  3400 
- E-Plus   7676245. 
Then a comma (,) follows the end of a code, followed by 
the e-mail address, e.g. “8000,receiver@provider.net” if 
using a T-Mobile SIM card. 
 
Transmission as fax:  
Enter the code “99” directly preceding the fax number, 
e.g.: “99057123456789”. 

Internet 
Host address Enter the host address of the corresponding Web server, 

e.g. “www.to-pass.com” for testing. 
Host port 80 
Script (values) Enter the sript name of the corresponding database, e.g. 

“wago/savedataM15.php” for testing. 
Script (logger) No entry here, if script name has been entered at Script 

(values)! 
Access server Enter the name of the access server of the provider of the 

SIM card, e.g.: 
- T-Mobile:  internet.t-mobile 
- Vodafone:  web.vodafone.de 

User Regardless 
Password Enter the password for the access server, e.g.:  

- T-Mobile:  T-D1 
- Vodafone:  d2 

 

http://www.to-pass.com/
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10.5 Input and Output Configuration 

10.5.1 Digital Inputs 

Select the TO-PASS® S telecontrol module from the project tree on the left using 
the identity. Select the input to be configured under the entry Digital input.  
The parameters of the input are given on the right side.  
The input fields are identical for all digital inputs: 

 

Figure 16: Configuring the digital inputs 

Alarm settings 
Set Text Message text of the transmitted message when the digital 

input is set. 
Address Selection of where the message should be transmitted if 

the digital input is set. One or all addresses can be 
selected independently. Press the [Internet] button for 
applications having cyclic GPRS transmission. 

Analog value Up to four analog values can be clicked here, which 
should be transmitted in addition to the fault message. 

Reset Text Message text of the transmitted message when the digital 
input is reset. 

Address Selection of where the message should be transmitted if 
the digital input is reset. One or all addresses can be 
selected independently. Press the [Internet] button for 
applications having cyclic GPRS transmission. 

Analog value Up to four analog values can be clicked here, which 
should be transmitted in addition to the fault message. 
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10.5.2 Multiplex Input 

The digital inputs DI1 … DI4 can be configured as multiplex inputs. In such a 
case, these four inputs are read in as a combination and interpreted as a binary 
number. The following applies in this case: 

 DI1 = 20 = 1 
 DI2 = 21 = 2 
 DI3 = 22 = 4 
 DI4 = 23 = 8 

Thus, for example, if DI1 and DI3 are set, then the binary number is 5. If only DI4 
is set, then the binary number is 8. 

An alarm text can be defined for each of the 16 states (0 … 15). The recipients of 
the alarm text message are selected with the help of the multiplex settings. 

10.5.2.1 Multiplex Settings 

Select the TO-PASS® S telecontrol module from the project tree on the left using 
the identity. Select the Multiplex Settings option under the Multiplex Input 
entry. The buttons for enabling multiplex operation and the selection of the 
recipients of the analog values to be transmitted are provided on the right side. 

 

Figure 17: Configuring the multiplex settings 

Using/Address 
Multiplex Mode Press the button [Use] to enable or disable multiplex 

operation for the inputs DI1 … DI4.  
Address Selection of where the message should be transmitted if 

the multiplex input has been set. One or more, or all 
addresses can be selected independently. Press the 
[Internet] button for applications having cyclic GPRS 
transmission. 

Analog Values Up to four analog values can be clicked here, which 
should be transmitted in addition to the multiplex 
message. 
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10.5.2.2 Multiplex Alarm Texts 

Select the TO-PASS® S telecontrol module from the project tree on the left using 
the identity. Select the Multiplex Table option under the Multiplex Input entry. 
The input fields for the alarm texts pertaining to the 16 states are provided on the 
right side. 

 

Figure 18: Configuring the multiplex alarm texts 

Alarm Text 
Value 0  
... 
Value 15 

Enter the various alarm texts to be transmitted for each of 
the states pertaining to the digital inputs. 
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10.5.3 Analog Inputs 

Select the TO-PASS® S telecontrol module from the project tree on the left using 
the identity. Select the input to be configured under the entry Analog input.  
The parameters of the input are given on the right side.  
The input fields are identical for all analog inputs: 

 

Figure 19: Configuring the analog inputs 

Norm settings 
Input range Select the input signal for the sensor connected to the 

TO-PASS® S telecontrol module. 
Min. value Starting value, from which the given value is normalized. 

This value corresponds to the minimum input current 
value of 4 mA or 0 mA. 

Max. value End value, up to which the given value is normalized. 
This value corresponds to the maximum input current 
20 mA. 

Unit Enter the unit here with a maximum of 5 characters with 
which the normalized process value should be 
transmitted. 
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Alarm settings 
First value First limit value, from which an alarm indication is 

triggered. Select whether the alarm indication should be 
triggered with overshoot or undershoot of the limit value. 

First text Alarm message that is triggered with overshoot or 
undershoot of the limit value. 

Address Selection of where the message should be transmitted. 
One or all addresses can be selected independently. Press 
the [Internet] button for applications having cyclic 
GPRS transmission. 

Analog value Up to four analog values can be clicked here, which 
should be transmitted in addition to the alarm message. 

Second value Second limit value, from which an alarm indication is 
triggered. Select whether the alarm indication should be 
triggered with overshoot or undershoot of the limit value. 

Second text Alarm message that is triggered with overshoot or 
undershoot of the limit value. 

Address Selection of where the message should be transmitted. 
One or all addresses can be selected independently. Press 
the [Internet] button for applications having cyclic 
GPRS transmission. 

Analog value Up to four analog values can be clicked here, which 
should be transmitted in addition to the alarm message. 
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10.5.4 Digital Outputs 

Select the TO-PASS® S telecontrol module from the project tree on the left using 
the identity. Select the output to be configured under the entry Digital output.  
The parameters of the output are given on the right side.  
The input fields are identical for all digital outputs: 

 

Figure 20: Configuring the digital outputs 

Settings 
Set text If the TO-PASS® S telecontrol module receives this text 

as an SMS, it switches this digital output on and connects 
the DC voltage available at terminal 37 to the 
corresponding digital output. 

Reset text If the TO-PASS® S telecontrol module receives this text 
as an SMS, it switches this digital output off and 
disconnects the DC voltage available at terminal 37. 

Reset time If the digital output is switched on, it will remain on for 
this time period and thus connected to terminal 37. After 
the reset time expires, the digital output switches off 
voltage from terminal 37. The “0” value disables this 
function; i.e., the output remains active indefinitely after 
being switched on. 
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10.6 Configure Fault Indicator 
The TO-PASS® S telecontrol module can transmit fault messages to maximum 
four receivers. The receivers are informed either directly one after another or (if 
configured) after expiration of the time delay for acknowledgment. The message 
is sent by the TO-PASS® S telecontrol module as an SMS; however, it can also be 
sent as an e-mail, fax or voice mail via configuration. 

10.6.1 Alarm messages from Digital Inputs 

If on or off states of digital inputs are to be sent as fault messages, then select the 
desired receiver for the respective states of the inputs with the help of the buttons 
[1] …[4]. In addition, it is possible to specify the analog values that are 
transmitted along with the fault message. 

10.6.2 Limit Value Messages of Analog Inputs 

It is possible to specify a maximum of 2 limit values for every analog input for 
which limit value violations (overshoot or undershoot) should be sent as fault 
messages. 
Enter the desired value and select whether the fault message should be sent for 
overshoot or undershoot of the limit value using the buttons [rise] or [fall]. 
Select the desired receiver for the respective limit value using the buttons [1] … 
[4]. In addition, it is possible to specify the analog values that are transmitted 
along with the fault message. 
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10.6.3 Acknowledgement 

Acknowledgment is the confirmation that a message has actually been sent to the 
receiver. Select the TO-PASS® S telecontrol module from the project tree using 
the identifier. Select the entry Quit function under the option Special functions.  
The right side contains the input fields for the waiting time and the number of 
repetitions. 

 

Figure 21: Configuring the acknowledgment response 

Settings 
Wait time The TO-PASS® S telecontrol module waits briefly to be 

entered here and acknowledgment after it has transmitted 
an alarm message. The acknowledgment takes place with 
the help of a simple call by the receiver to the TO-PASS® 
S telecontrol module.  
The TO-PASS® S telecontrol module accepts the call and 
disconnects it automatically. An acknowledgment SMS 
with the identifier and the text “QUIT” is sent. 

Repeat cycles Set the cycle time here for checking for the 
acknowledgment. If no receiver acknowledges the 
message of the TO-PASS® S telecontrol module, then the 
entire cycle can be executed again, allowing the TO-
PASS® S telecontrol module to inform the first address 
once again and wait for an acknowledgment. 
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10.7 Transmission Refresh Times 
Select the TO-PASS® S telecontrol module from the project tree using the 
identifier. Select the entry Refresh times under the option Special functions.  
The input fields for the web interval and the SMS interval are located on the right 
side. 

 

Figure 22: Configuring the transmission repeat times 

Settings 
WEB cycle time Enter the cycle time here in minutes, which are intervals 

that the TO-PASS® S telecontrol module should transmit 
to the Internet. 
If “0” is entered, the transmission is disabled. 
It is possible to enter a maximum value of 9999 minutes, 
which corresponds to approximately one transmission per 
week. The cycle time set determines the transmission 
costs.  
One transmission corresponds to approx. 1 kB. 
If setting a cycle time of 60 minutes (one transmission 
per hour) then the data volume generated per month is 1 
kB * 24 hours * 30 days = 720 kB per month. 
A SIM card with an inclusive volume of 1 MB per month 
would suffice for this cycle time. 

SMS cycle time Enter the cycle time here in minutes at which the TO-
PASS® S telecontrol module should transmit to the first 
receiver address configured.  
The SMS contains the status of the digital inputs, the 
values and units of the analog inputs, the status of the 
digital outputs and the values and units of the analog 
outputs.  
The cyclic SMS can, for example, be used for operational 
supervision. 
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10.8 Time Control 
Select the TO-PASS® S telecontrol module from the project tree using the 
identifier. Select the entry Time control under the option Special functions.  
The buttons for various settings pertaining to time adjustment are located on the 
right side. 

 

Figure 23: Setting the time adjustment 

Settings 
Time set If the [SMS] button is pressed, then the TO-PASS® S 

telecontrol module sends an SMS to itself and receives 
the current time from the time transmitted by this SMS.  
The time adjustment using an SMS takes place only once 
when the TO-PASS® S telecontrol module is restarted. 
This type of time adjustment using SMS transmission has 
an inaccuracy of approximately 10 seconds.  
If the [Internet] button is pressed, then the TO-PASS® S 
telecontrol module receives the time from the Internet 
server with every cyclic transmission to the Internet. This 
type of time adjustment using transmission to the Internet 
server has an inaccuracy of approximately 3 seconds. 
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10.9 Write Parameters 
After you have adapted all parameters to your requirements, you have to write 
these parameters to the module connected. 

For this purpose, select the menu point Controller > Write Parameters. The 
software now writes all the parameters into the TO-PASS® S telecontrol module. 

Then the TO-PASS® S telecontrol module is ready for operation. 
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11 Handling 
11.1 Remote Query of Process Values 

The TO-PASS® S telecontrol module offers two options for remote query of the 
process values available. 

• query via SMS 
• query with the TO-PASS® operator program. 

11.1.1 Query via SMS 

For query via SMS, please send an SMS with the text “State” to the TO-PASS® S 
telecontrol module. The TO-PASS® S telecontrol module responds promptly with 
an SMS containing all digital and analog process values to a mobile telephone. 

Table 13: SMS installation 
Value transmitted Description 
Module 1 Identity 
10010011 Condition of the digital inputs 1 ... 8 

(0 = not set, 1 = set) 
+00000 mA Analog input 1 
+00000 mA Analog input 2 
+00000 mA Analog input 3 
+00000 mA Analog input 4 
+00000 mA Analog input 5 
+00000 mA Analog input 6 
+00000 mA Analog input 7 
+00000 mA Analog input 8 
0110 Condition of the digital outputs 1 ... 4 

(0 = not set, 1 = set) 
+00000 mA Analog output 1 
+00000 mA Analog output 2 
AC=99 Alarm counter 

(displays the alarms that are still possible per hour) 
From:+0123456789 Telephone number of the TO-PASS® S telecontrol module
hh:mm dd-mm-yy Time and date of the SMS 
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11.1.2 Query with the TO-PASS® Operator Program 

For a process values query with the TO-PASS® operator program, please select the 
menu option Visual > I/O values. The program establishes a link to the TO-
PASS® S telecontrol module selected. Please note the mode of accessing the TO-
PASS® S telecontrol module, either via direct RS-232 cable connection or an 
analog ISDN or GSM modem dial-up. The selection is specified in the menu 
option File > Set. 

 

Figure 24: Visualization of the process values 

Press the [I/O] button to display the process values of the digital and analog 
inputs and outputs. The process values displayed are valid if the on-line display is 
green. 

Process values pertaining to digital and analog inputs are displayed in the upper 
portion of the window and those pertaining to digital outputs are displayed in the 
lower portion of the window. 
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11.2 Telecontrol 
TO-PASS® S telecontrol modules offer the option of influencing a process 
remotely with the help of their analog and digital outputs. There are two methods 
available: 

• telecontrol via SMS 
• telecontrol  with the TO-PASS® operator program. 

11.2.1 Telecontrol via SMS 

To set or reset a digital output, please send an SMS with the text that is entered 
under Set text and/or Reset text for this output to the TO-PASS® S telecontrol 
module.  
The TO-PASS® S telecontrol module acknowledges the command with an SMS 
containing the identifier, the text sent and the current reading of the alarm counter. 

Example: 

Table 14: Example of parameter for Set DO 
Parameter Setting 
Set DOUT1=1 
Reset DOUT1=0 
Reset time 0 
 
Send an SMS with the text “DOUT1=1” to the TO-PASS® S telecontrol module in 
order to switch on the output 1.  
The TO-PASS® S telecontrol module acknowledges the command with an SMS 
with the identifier, the text “DOUT1=1 OK!”. 

Send an SMS with the text “DOUT1=0” to the TO-PASS® S telecontrol module in 
order to switch off the output 1. 
The TO-PASS® S telecontrol module acknowledges the command with an SMS 
containing the identifier, the text “DOUT1=0 OK!”. 
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11.2.2 Telecontrol with the TO-PASS® Operator Program 

For a process values query with the TO-PASS® operator program, please select the 
menu option Visual > I/O values. The program establishes a link to the TO-
PASS® S telecontrol module selected. Please note the mode of accessing the TO-
PASS® S telecontrol module, either via direct RS-232 cable connection or an 
analog ISDN or GSM modem dial-up. The selection is specified in the menu 
option File > Set. 

 

Figure 25: Visualization of the process values 

Press the [I/O] button to display the process values of the digital and analog 
inputs and outputs. The process values displayed are valid if the on-line display is 
green. 

Process values pertaining to digital and analog inputs are displayed in the upper 
portion of the window and those pertaining to digital outputs are displayed in the 
lower portion of the window. 

You can set or reset the digital outputs by pressing the buttons [Set/Reset]. 
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11.3 Acknowledge Fault Messages 
If a waiting time not equal to 0 has been set for the acknowledgment of fault 
messages, then the TO-PASS® S telecontrol module expects an acknowledgment 
of fault messages from the receiver. 

The acknowledgment occurs via a simple call to the TO-PASS® S telecontrol 
module. 

Select the TO-PASS® S telecontrol module and the connection is established after 
2 or 3 ring signals. Finally, the connection to the TO-PASS® S telecontrol module 
is interrupted. The fault message is thus acknowledged. In addition, the TO-
PASS® S telecontrol module sends an SMS with the text “Quit”. 

NOTE: 

 

Waiting time 
When the TO-PASS® S telecontrol module waits for an acknowledgment it 
is inactive for other tasks. Both the “Run” and “Busy” LEDs also light up. 
During the waiting time no messages are sent and no commands are 
accepted. 

If the message in not acknowledged within the waiting time set, then the TO-
PASS® S telecontrol module sends the fault message automatically to the next 
receiver entered under addresses and waits again for the defined waiting time for 
an acknowledgment. 

If none of the receivers defined acknowledge the fault message and the number of 
repetitions is not set to 0, then the procedure is repeated until one receiver 
acknowledges the fault message or the maximum number of repetitions has been 
reached. 
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11.4 Switch Stand-by State 

NOTE: 

 

Stand-by state authorization 
Switching the ready state on and off is only possible by subscribers whose 
telephone number has been entered in the address list! 

Using the “Standby” function, it is optional to change all messages sent by the 
TO-PASS® S telecontrol module specifically to the respective standby state. This 
takes place with simple changeover via SMS. 

To do this, send an SMS with the text “Standby1” to the TO-PASS® S telecontrol 
module. The TO-PASS® S telecontrol module then transmits all alarm messages to 
the SMS sender. Other receivers defined in the TO-PASS® S telecontrol module 
are no longer informed. 

In order to switch this function off send an SMS with the text “Standby0” to the 
TO-PASS® S telecontrol module. 
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12 Diagnostics 
12.1 Test Inputs and Outputs 

To test the inputs and outputs select the menu option Controller > Test I/O. The 
following window is displayed: 

 

Figure 26: Test inputs and outputs 

The states of the digital and analog inputs are displayed in the upper region. By 
pressing the buttons [1] … [4] in the upper region switch digital inputs on and off. 

Press the [Exit] button to end the test and close the window. 

Alternatively, the inputs and outputs can also be tested with the help of the menu 
option Visual > I/O values. 
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12.2 Test the Connection 
To test the connection, select the menu option Controller > Test SMS/GPRS. 
The following window is displayed: 

 

Figure 27: Test the connection 

Select the address to send an SMS and enter the text to be sent. Press the [Send] 
button to send the message. The status of the transmission is finally displayed. 

Press the [Exit] button to end the test and close the window. 

12.3 Test the Modem 
To test the link, select the menu option Modem > Test. The following window is 
displayed: 

 

Figure 28: Modem test 

Connection is established and the signal strength is displayed. 

Press the [Exit] button to end the test and close the window. 
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13 WAGO-TO-PASS® Web 
GPRS data records V1.50 

13.1 Set Parameters 
Select the TO-PASS® S telecontrol module to be configured from the project tree. 
Select the option Addresses to enter the parameters for transferring data to a web 
server. 

You can use the WAGO server to test your application. For this purpose, please 
enter the values shown in table in chapter 10.4. 

Select the entry Refresh times under the option Special functions and set the 
WEB cycle time of the cyclic transmission to the server, e.g. 5 minutes. 

The communication as SMS or to the server can be tested under the menu option 
Controller > Test SMS/GPRS. Press the [Internet] button and enter any text, 
such as, e.g. “TEXT” in the field Unstructured Text. Then press the [Send] 
button. The reply "Web Refresh = 0" should follow after approx. 20 seconds. 

Now go to the Web address www.to-pass.com and press the [MyTO-PASS] 
button.  
Enter the user name as “test” and also the password as “test” and press the 
[Login] button.  
Select your TO-PASS® S telecontrol module from the list and press the [Display] 
button. 

http://www.to-pass.com/
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13.2 Web Refresh 
The HTTP method “POST” transmits the process image of the WAGO TO-PASS® 
telecontrol module to the Internet. A data record consists of from data in the 
context of the request. 

All data are transmitted as strings (ASCII characters) having a fixed length. 

13.2.1 Data Format 

Table 15: Data format Web Refresh 
Index Variable List of contents Format 
0 IS Identity Identity[8];Serial number[5] 
1 PA Parameter Cycle time[4];Provider[5];Alarm Counter[2] 
2 TI Date, Time YY/MM/DD,hh:mm:ss 
3 D1 Digital input 1 Value;Alarm 
4 D2 Digital input 2 Value;Alarm 
5 D3 Digital input 3 Value;Alarm 
6 D4 Digital input 4 Value;Alarm 
7 D5 Digital input 5 Value;Alarm 
8 D6 Digital input 6 Value;Alarm 
9 D7 Digital input 7 Value;Alarm 
10 D8 Digital input 8 Value;Alarm 
11 A1 Analog input 1 Value[6];Unit[5];Alarm 
12 A2 Analog input 2 Value[6];Unit[5];Alarm 
13 A3 Analog input 3 Value[6];Unit[5];Alarm 
14 A4 Analog input 4 Value[6];Unit[5];Alarm 
15 A5 Analog input 5 Value[6];Unit[5];Alarm 
16 A6 Analog input 6 Value[6];Unit[5];Alarm 
17 A7 Analog input 7 Value[6];Unit[5];Alarm 
18 A8 Analog input 8 Value[6];Unit[5];Alarm 
19* US Sub-structured string Data[40] 
20** EMPL Modbus-Alarm Value[2];Status[2];Alarm 
21** MV Modbus variables 64 x Value[4]; 
* The variable is sent only if a Web refresh occurs via serial interface.  
** The variables are sent only if Modbus is switched on. 

NOTE: 

 

Alarm flags with multiplex function 
If the multiplex function is used then all alarm flags from D1 to D4 are ‘1’ 
for a multiplex alarm. 
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13.2.2 Response 

The response to the request contains a string and optionally the time of the server. 

The server time adjusts the time of the WAGO TO-PASS® telecontrol module. 

The response string must be located within the first 250 characters of the HTML 
page (incl. HTTP header). 

“Values stored” 

Date and time are optional and are required only if the time of the WAGO TO-
PASS® telecontrol module is to be set via server. 

“Values stored:YY/MM/DD,hh:mm:ss” 

The server can also report that the data was not accepted if, for example, a WAGO 
TO-PASS® telecontrol module is connected and the operator has made an 
incorrect input. 

“Values not stored” 

13.2.3 Example (Request) 
ID=TopasM01;12345 
PA=0060;26201;99  (�  Cycle time= 60 min, registered at T-
D 1,  
TI=05/12/02,14:27:59   �  another  99  alarms are possible) 
D1=0;0 
D2=1;0 
D3=1;1    (this value has triggered an alarm) 
D4=0;0 
D5=0;0 
D6=0;0 
D7=0;0 
D8=0;0 
A1= 0.123;bar  ;0 
A2= 25.40;degree ;0 
A3= 71.50;degree ;0 
A4= 0.000;mA   ;0 
A5= 0.000;mA   ;0 
A6=-0.000;mA   ;0 
A7=-0.000;mA   ;0 
A8=-0.000;mA   ;0 
US=Hello  you there ! 
MA=00;00;0 
MV=0000;0001;0002;0003; ... 0063 

Example (Response): 

Values stored:05/12/02,14:28:05 
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13.3 WebLog 
In addition to Web Refresh the data records of the data and event loggers can also 
be sent to a script of the server. One packet contains 10 compressed data records 
of 14 bytes each. 

13.3.1 Data format 

Table 16: Data format WebLog 
Index Variable List of contents Format 
0 IS Identity Identity[8];Serial number[5] 
1 PA Parameter Cycle time[4];Provider[5];Alarm Counter[2] 
2 TI Date, Time YY/MM/DD,hh:mm:ss 
3 LO Data sets of teh Logger Log[140] 
 

13.3.2 Data Format of a Data Record 
Byte: 0       1       2       3       4       5       6        

Bit:  76543210765432107654321076543210765432107654321076543210 

Cnt.: PNNNNNNNSJJJJJMMMMDDDDDhhhhhmmmmmmssssssDIN.....AIN1.... 

 

Byte: 7       8       9       10      11      12      13       

Bit:  76543210765432107654321076543210765432107654321076543210 

Cnt.: AIN2....AIN3....AIN4....AIN5....AIN6....AIN7....AIN8.... 

 

P:  Pointer for the next data set to be saved 

NNNNNNN: Event number 

S:  Data records already sent 

YYYY: Year 

DDDDD: Day 

MMMM: Month 

hhhhh: Hour 

mmmmmm: Minute 

ssssss: Second 

DIN.....: Digital inputs 

AINx....: Analog input channel x (x = 1 ... 8)  
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13.3.3 Use 

The reception must be acknowledged with “Values stored” (refer to Web 
Refresh). 

The data records must be decompressed on the server. 

The data records with the bits set P=1 or S=1 are invalid and must be deleted. 

The data records on the server must be sorted with respect to date/time. 
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14 Disclaimer 
TO-PASS® Telecontrol Modules communicate using the GSM network (Global 
System for Mobile Communication). Exemptions cannot be made for GSM 
services used by the TO-PASS® telecontrol modules as they may be exposed to 
faults in the service provider’s network. WAGO Kontakttechnik GmbH & Co. 
KG has no involvment with these types of problems. 

Therefore, WAGO Kontakttechnik GmbH & Co. KG will reject any guarantee for 
the implementation of commands transmitted from and received by the TO-PASS® 
telecontrol module. 
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15 Technical Data 
Table 17: Technical data  Inputs 
Number of inputs Digital 4 (5 V ... 24 V) 

Analog 8 (0/4 mA ... 20 mA) 
Input voltage digital inputs (24 V) max. 1.6 mA 
Interior resistance analog inputs 250 Ω 
 

Table 18: Technical data Outputs 
No. of outputs Digital: 4 contacts 

Analog: 2 (0/4 mA ... 20 mA) 
Load of digital outputs AC/DC 60 V/1 A 
 

Table 19: Technical data General 
Number of recipients 4 (PC, SMS, e-mail, phone, fax) 
Communication  GSM Quadband 
Communication types SMS (bidirectional), 

DFÜ selection connection (CSD), 
GPRS connection to Internet 

Operating voltage DC 8 V ... 36 V 
Closed current 40 mA 
Current during transmission < 600 mA 
Type of mounting TS 32 DIN rail 
Wire connection Spring type connection 
Dimensions (W x H x D) 109 mm x 105 mm x 78 mm 
Weight approx. 426 G 
Operating temperature -20 °C ... +70°C 
Storage temperature -20 °C ... +70°C 
Degree of protection IP20 
EMC 1 Immunity to interference in acc. with EN 61000-4-6 (2001) 
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